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WHY AUDIO ON THE GPU

» HRTFs and occlusion are only the beginning of a realistic sound experience

» Sound reflections are needed to give the user the sense of “being in the

environment”
Subtle and unconscious, yet tied deeply into emotional cues and

engagement level

= Accurate positional reflections change continually with the environment as the®
user turns their head or moves In the scene
Can’t be done with statlc/pre -rendered reverbs, even when varied in the

scene
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WHY AUDIO ON THE GPU

» Simulating and rendering reflections with high-order

Ambisonics, as done in Steam Audio, results in sound
reflections that vary physically for improved immersion
and presence

= But there is a computational cost

Ray Tracing — simulating audio reflection paths

Convolution — use ray tracing results to filter sound
sources

= \What happens if you are too slow?

Ray Tracing — updates to the sound filters lag as you
move in the scene

Convolution: audio popping/dropouts

GDC 2019 |
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WHY AUDIO ON THE GPU

= Conventional coping strategies
Trace ~100 — 1000 realtime rays at best
1 — 2 time-varying convolutions, if any
= The GPU is great at ray tracing and convolution
Use Radeon Rays for ray tracing
Use TrueAudio Next for convolution
Additional OpenCL kernels to connect the two
= With GPU (in real-time)
16k rays per source, 4+ bounces

512 time-varying convolutions
) = 32 3"-order Ambisonics sources

-/But you need to do it the right way...

GDC 2019 |
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THE CONVENTIONAL GPU WORK MODEL
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» The compute shader portion of a GPU uses identical computing
blocks called workgroup processors or compute units

= Jobs consisting of kernels and data are submitted from an
application to the GPU through a compute queue

= The conventional working model for GPU compute

= Pushes all work through a single compute queue, targeting the entire
array of compute units with each job

* Runs jobs from different applications in series, but as fairly as
possible*

= This design is very performant for massively parallel applications,
and provides excellent throughput for multiple compute
applications if they do not have absolute periodic latency
requirements

* *Note: VR display refresh gets specific treatment &

7 | GDC2019 | Qe AMDI‘J‘
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. What can go wrong when using the conventional model for audio?

Graphics and compute performance on a game is tuned to run well on the
conventional model

Throwing audio into this mix can add performance uncertainty ?{
» |f aray tracing kernel takes too long, graphics frame rate may vary unpredict

= |f a graphics kernel takes too long, convolution can miss a deadline, causing audio
glitches

What do we want? ;!%\\_
Predictable’ execution times | J
Preventing some kernels from varying performance of other kernels 4
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HOW TO SUCCESSFULLY RUN AUDIO ON
THE GPU IN A GRAPHICS-INTENSIVE:GAME

Use AMD Resource Reservation:

* Designed to allow one or two configurable,
small portions of the GPU compute array to
be partitioned away from the rest of the
compute units and mapped one-to-one to
specific, dedicated queues called Real-time




HOW TO SUCCESSFULLY RUN AUDIO ON
THE GPU IN A GRAPHICS-INTENSIVE GAME

= AMD Resource Reservation provides a number of important design features:

 RTQs are allocated and released from within the application and are released when
the application closes for any reason

« Kernels running on an RTQ can’t use CUs that belong to other queues, kernels
running on other queues can’t use reserved CUs

-

« Kernels can’t adversely affect schedule of workloads running on other queues =
 RTQs are limited to up to ~25% of the total CUs in a GPU ; \\ N
« Each partition’s workload becomes self-limiting. If an RTQ’s workload is | 3N

oversubscribed, only its own performance is impacted oy A\
« Memory and bus bandwidth are still shared between all queues, but interaction L \
effects are less significant l/ i
» Profiling by AMD for a stress use case shows that any reduction in frame rate of an y - ‘
intensivg*gaming benchmark is less than or equal to the percentage of total CUs i
reserve |

~_~ _~*See claim-details in Endnotes
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AUDIO ACCELERATION WITH TRUEAUDIO NEXT
(TAN) AND RADEON RAYS IN STEAM AUDIO

« Steam Audio includes optional support for Radeon Rays and TrueAudio Next in real-
time
e On supported GPUs:
« RTQ 1 is used to accelerate audio convolution with AMD TrueAudio Next (TAN)
« RTQ 2 is used to accelerate simulation of audio reflections, consisting of multiple
stages:
* Ray tracing using Radeon Rays

« Using ray tracing results to calculate impulse response (IR)
* Preparing IRs for convolution using Fast Hartley Transform (FHT)

 Can also use CPU-based ray tracing with TAN on GPU
In this case, RTQ 2 is still used for FHT

« Example: on Radeon™ RX Vega 64, use 4 CUs for TAN convolution (RTQ 1), 8 CUs for

reflection simulation (RTQ 2), remaining 52 CUs are allocated to graphics and non-RTQ
compute : - : .
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STEAM AUDIO AND
TRUEAUDIO NEXT +
RADEON RAYS

Lakulish Antani
Valve Corporation
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QUICK TUTORIAL

This tutorial is based on the Steam
Audio Unity plugin and Unity’s native
audio engine

For information on other
integrations, see the Steam Audio
docs

| GDC 2019 |
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QUICK TUTORIAL : STEP 1

Enable Steam Audio spatialization AudioManager
Click Edit > Project Settings > Audio

Set Spatializer Plugin to Steam Audio
Spatializer

Global Volume 1

Volume Rolloff Scale 1

Doppler Factor 1

Default Speaker Mode | Stereo

System Sample Rate 0

DSP Buffer Size Best performance
Max Virtual Voices 512

May Real Vnires 22

Spatializer Plugin Steam Audio Spatializer

AMDISonic Decoder Piug| Mone
Disable Unity Audio
Virtualize Effects v

14 | GDC2019 | @iﬂ%ﬁ;" AMDZA



QUICK TUTORIAL : STEP 2

vJ + Audio Source Static ¥
Tag | Untagged | Layer | Default s
= Set up Audio Sources to be TN Tamstorm  __ @ae
spatialized Fotaion O 4 C—C—
= Select Audio Sources, check o
Spatlallze Output ‘None (Audio Mixer Group)

Mute

Bypass Effects

Bypass Listener Effects
Bypass Reverb Zones
Play On Awake

Loop

Priority

Volume

Pitch

Stereo Pan
Spatial Blend
Reverb Zone Mix

30D Sound Settinas
Spatialize
SpatiallZze FOST ETTeC]

15 | GDC2019 | 9 ‘oo AMDZ



QUICK TUTORIAL : STEP 2

' Steam Audio Source (Script)

= Set up Audio Sources to be
spatialized

= Select Audio Sources, check
Spatialize

= Enable indirect sound

» Add a Steam Audio Source
component to the Audio Source

= Check Reflections

16 | GDC2019 |

Direct Sound

Direct Binaural v

HRTF Interpolation Mearest

Direct Sound Occlusion| ©On, No Transmission
Occlusion Method Raycast

Physics Based Attenuat

Air Absorption

Direct Mix Level

Directivity
Dipole Weight
Dipole Power

Preview

Tndiracrt Cannd

Reflections v
Simulation Type Realtime
Indirect Mix Level

Indirect Binaural

Go to Window > Phonon > Simulation to update the global
simulation settings.

Advanced Options

9 AMDIO



© Inspector Steam Audio

QUICK TUTORIAL : STEP 3 s

Audio Engine Integration
Audio Engine Unity

HRTF Settings
SOFA Files
Current SOFA File Default

» Adjust simulation settings T
= Click Window > Steam Audio seeow

» Adjust Realtime Rays, Duration,
Ambisonics Order, etc. L e

Duration (s)
Ambisonics Order

Max Sources
Irradiance Min Distance

Realtime Settings
Realtime Rays

Realtime Secondary Rays
Realtime Bounces
Realtime CPU Cores (%)

Baking Settings
Bake Rays

Bake Secondary Rays
Bake Bounces

Baking CPU Cores (%)

Occlusion Settings
Occlusion Samples

Advanced Options
Per Frame Query Optimization
Consolidated Baking Options

17 | GDC2019 | ) s AMDIL



QUICK TUTORIAL: STEP 4

Steam Audio Custom Settings (Script)

Simulation Settings

Ray Tracer Radeon Rays

= Enable TrueAudio Next and Radeon Rays Rendering Settings
. . Convolution Option | TrueAudio Next
= Select Steam Audio Manager Settings POy e rrr
= Add a Steam Audio Custom Settings component Baking Batch Size
u Set Ray Tracer to Radeon Rays GPU Resource Reservation

Max Compute Units To )

= Set Convolution Option to TrueAudio Next AL S e

Override Simulation Settings
Duration >

Ambisonics Order
Max Sources

Radeon Rays is supported on Windows (64-bit). On all other
platforms, Steam Audio will revert to Phonon ray tracing.

TrueAudio Mext is supported on Windows (64-bit). On all other
platforms, Steam Audio will revert to Phonon convelution. All
scenes in the application that use TrueAudio Next should use the
same settings for Max Compute Units To Reserve and Fraction
Rays Compute Units for IR Update,

Radeon Rays can be used either for baking or real-time indirect
sound. Using Radeon Rays with real-time indirect sound requires
Convolution Option be setto TrueAudio MNext,

The Steam Audio Custom Settings component should be placed
beneath the Steam Audio Manager component in the Inspector
Window.

| GDC 2019 |




CU RESERVATION

Configure GPU Resource Reservation
settings in the Steam Audio Custom
Settings component

Max Compute Units: total number of
CUs to use for audio

Fraction Compute Units for IR Update:
the percentage of reserved CUs to use
for IR update

= Ray tracing, IR reconstruction, FHT

| GDC 2019 |

Steam Audio Custom Settings (Script)
Simulation Settings

Ray Tracer Radeon Rays

Rendering Settings
Convolution Option | TrueAudio Next

Radeon Rays Settings
Baking Batch Size

GPU Resource Reservation
Max Compute Units To 9,

Fraction Compute Units

Override Simulation Settings
Duration -
Ambisonics Order

Max Sources

Radeon Rays is supported on Windows (64-bit). On all other
platforms, Steam Audio will revert to Phonon ray tracing.

TrueAudio Next is supported on 1\'Ind( ws (64-bit). On all other
platfulms. S n A ': artto P lution. All

2 wt should use the
same s»-ttlngsf r Max Compute i o Reserve and Fraction
Rays Compute Units for IR Update,

Radeon Rays can be used either for baking or real-time indirect
sound. Using Radeon Rays with real-time indirect sound requires
Convolution Option be set to TrueAudio Next,

The Steam Audio Custom Settings component should be placed
eath the Steam Audio Manager component in the Inspector

0) STEAM’

AUDIO
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CU RESERVATION

* Choosing total number of reserved CUs
= Driven by overall GPU workload

= Choosing the fraction of reserved CUs used for IR update
= Higher IR duration, Ambisonics order: spend more CUs on convolution

= Many sources, complex scenes: spend more CUs on IR update
= Test!

= Note: If using TAN with CPU ray tracing, spend 50% of reserved CUs on IR
update

| GDC 2019 | gsALED’lg"' AMDa



MIXER RETURN EFFECT

=  Unity Mixer Effect: apply DSP processing
to a submix from multiple audio sources

=  When using TAN, always create a Steam
Audio Mixer Return Effect:

= Create at least one Mixer Group
= Add Steam Audio Mixer Return effect

= Set the output of the Audio Source to this
Mixer Group

| GDC 2019 |

v Audio Source
AudioClip

Master (Master)
Bypass Effects

Bypass Reverb Zones
Play On Awake v
Loop v
Priority

Volume

Pitch

Stereo Pan

Spatial Blend

Reverb Zone Mix

3D Sound Settings
Spatialize v
Spatialize Post Effec

ion

iti Audio Mixer

Master

Steam Audio

9 AMDIO



MIXER RETURN EFFECT

= With Mixer Return Effect: audio sent to the GPU for processing in a single batch
= Without: audio sent to the GPU once per source, incurring overhead

= Audio is taken out of Unity’s pipeline at the Audio Source, reintroduced at the
Mixer Return Effect

» Can’tinsert per-source DSP between spatializer and mixer

| GDC 2019 | gsALED’lg‘A AMDa



SETTING UP A GOOD CPU FALLBACK SCENARIO

If the user’s hardware doesn’t support GPU functionality, Steam Audio will automatically fall back to CPU

If falling back to CPU for ray tracing:
. Reduce the number of rays, bounces (linear speedup)
o Reduce the number of sources that use propagation (linear speedup)

. If possible, increase the number of CPU threads used for propagation (close to linear speedup)
o If supported, use Embree

If falling back to CPU for convolution:
Reduce the Ambisonics order to 0 or 1 (quadratic speedup)
Reduce the IR duration (linear speedup)

This behavior is customizable in Steam Audio integration code, which is open source

| GDC 2019 | gsALED’lg"' AMDa



RADEON RAYS AND BAKING

Baking: precompute sound
propagation from static sources
Like global illumination
Geometry must also be mostly static

Radeon Rays can be used to
accelerate baking as well

In this case, disable CU reservation,

use the entire GPU for simulation

Example speedups on Radeon™
RX Vega 64: 10-30x faster than
single-core Embree

| GDC 2019 |

Steam Audio Custom Settings (Script)

Simulation Settings
Ray Tracer Radeon Rays

Rendering Settings

Convolution Option TrueAudio Next

Radeon Rays Settings
Baking Batch Size

GPU Resource Reservation
Max Compute Units To (O

ec so
of the abo

Fraction Compute Units

etting maximum number of requ

resel'.'ation 'rorTlueAudio Iln“tl th ntire GPU will be

fth b slide

audi g To able CU . rvation, increas eth-:-

@ = =,

tdt‘u to 1d bI s CU

ed for
ralue of

Average Reverb Baking Speedup

62.1x speedup
Hangar

153.9x speedup

Sibenik
5.2x speedup

1.0 10.0 100.0 1000.0
mRadeon Rays ®Embree

0) STEAM’
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https://steamcommunity.com/games/596420/announcements/detail/1681419156989664451

AMD RESOURCE
RESERVATION
DESIGN
FEATURES




* Apool of up to ~25% of the TAN for Real-time

» Available CUs may be

« OK to use acceleration in some

26

AMD RESOURCE RESERVATION: CONSISTENT,
SCALABLE REAL-TIME PERFORMANCE

available CUs on a GPU may Audio Buffers
be allocated to 2 RTQs. CUs
can be allocated in blocks of 4

Radeon Rays for
Audio Propagation

distributed to TAN and Radeon
Rays under direction of
parameters provided from the
game to the Steam Audio API

* TAN can be used with Radeon Compute

Rays, or with a CPU-based ray Shaders
tracer (choice is left to the
game developer)

scenes, CPU-only in other
scenes

| GDC 2019 | @
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AMD RESOURCE RESERVATION PROVIDES CONCURRENCY AND
INDEPENDENCE OF AUDIO AND GRAPHICS + COMPUTE

Adapter [Radeon RX Vegal

GFX Queue Hardware Queue H i

Hardware Queue

Copy
TAN RTQ Hardware Queue
Sopy
Radeon Rays
& Steam Hardware Queue
Audio RTQ e | — O 0 B

Hardware Queue

20 naus - elan

Other Compute Hardware Queue T w1
Shader ST T

This Windows Performance Recorder capture trace (as seen in GPUView) shows four queues running
mhde endently on one GPU, in a Direct X® 12 scenario: TAN, Radeon Rays, 3D graphics, and a gaming compute
shader process

27 | GDC2019 | @iﬂ%ﬁ‘g AMDZ




RESOURCE RESERVATION PARAMETERS AND
OPTIONS

 (CUs are allocated from the available pool of reservable CUs. A GPUUltilities
query is made from Steam Audio to determine:

« Total number of reservable CUs (currently 8, 12, or 16)

« Minimum reservation granularity (currently units of 4)

« Whether Dual RTQ is supported (current AMD Radeon™ Software Adrenalin 2019 Edition
drivers support it)

« GPU’s relative TAN audio convolution performance (AMD Radeon™ RX 480 = 1.0). *Note
this is not indicative of the GPU’s graphics performance

 The CUs reserved are allocated between the two RTQs by Steam Audio
« Recommend 4 CUs for TAN convolution, and 4 to 12 for the second RTQ

« The second RTQ runs the full propagation stack if Radeon Rays real-time is used, otherwise
it runs the fast-Hartley transform on impulse responses received from the CPU ray-tracer

w S = @ Ay .
~
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MULTICORE
OPTIMIZATIONS -e :
OF AUDIO = ‘
CONVOLUTION IN =
TRUEAUDIO NEXT




MULTICORE OPTIMIZATION OF AUDIO
CONVOLUTION IN TRUEAUDIO NEXT

« Resource Reservation is only one part of the performance story of TrueAudio
Next convolution. There is also a bit of math involved

* An effective multi-core convolution implementation is essential in order to
minimize the latency of the convolution process that is directly visible to the

main audio buffer loop in the game engine

ffevs
y Convolution processing
CPU thread on GPU (don’t
udio 9 hold up the CPU
thread ethffers B .Up :
audio thread!)

Wheel of .

. Convolution
Processing time orocessing time
(e.g., 21 ms) Buffer

slice Other audio processing

switching . .
time (T0) Convolution time slot .
30 | GDC 2019 | 9 SALED?SA‘ AMDa



HIGH-LEVEL TAKEAWAY: THE IMPORTANCE OF
BATCHING FOR THE GPU

« Even though we are partitioning the GPU’s compute units, the audio workloads
we send to the GPU still need a "GPU-friendly” implementation to get high
throughput and utilization

« The way we achieve this is to batch the GPU calculations in each frame to the
maximum extent possible

 OpenCL allows us to parallelize kernels in up to three dimensions. We can
apply these dimensions anywhere that parallel calculations are possible:

Simultaneous sources

Simultaneous channels in an Ambisonics source
Multiple parts of a spectrum processed in parallel
...etc.

31 | GDC2019 | @iﬂ%@” AMDZ



CONVOLUTION AND THE CONVOLUTION
THEOREM (QUICK REVIEW)

Convolution is a generalized form of a filter, one that applies the impulse response of
an environment to a signal to model the effect of the environment upon the signal

 The convolution theorem is the basis of fast convolution. For audio signals, the
convolution theorem states that the convolution of two signals is equivalent to point-
wise multiplication of the Fourier transforms of those signals followed by the inverse

transform:
x ©Oy=IT(FT(x) * FT(y))

...where © is a convolution, * is an element-wise multiplication in the transformed space, FT
is a forward Fourier transform, and IT is the inverse Fourier transform

Why this matters: Point-wise multiplication of Fourier transforms is much
faster than brute-force convolution (Brute force: y[n] = Y:_1 x[k]h[n — k])

Despite this, fast convolution is still an expensive computation at large
scales. Even more so when the IR kernels are being updated periodically

32 | GDC2019 | @iﬂ%@"ﬂ AMDZ



FIRST OPTIMIZATION: USE FAST-HARTLEY
TRANSFORM INSTEAD OF FOURIER

For audio signals, which only have real values (no imaginary part),
the Fast Hartley Transform (FHT) is useful because it requires only
half of the memory of the Fast Fourier Transform (FFT), with only a

very small additional calculation overhead

Saving memory is important so as to maximize the memory
available to graphics and other compute processes

The FHT also obeys the convolution theorem
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SECOND LEVEL OF OPTIMIZATION: UNIFORM
PARTITIONED CONVOLUTION

Impulse Response buffer preloaded,

E.r:]r:e fi':r:e split into fixed blocks, FHT transformed
. Partitioned Convolution splits the '
IR buffer into fixed blocks HEREEEEER
(partitions) in the frequency >I—

domain to let them run faster

. Partitions have a uniform size
equal to the audio frame size
(typically 1024 samples). Zero-
pad excess

«  History buffer stores transformed
samples. Visible latency is same
as buffer size

New —>» Old*

Incoming blocks

3
History buffer

\4
. (Freg-Domain Delay
. ‘/ line, FDL)
A
4

Y
Nl

. In each buffer time slot:
1. Pointwise multiply-accumulate

all transformed history buffer oo <1<+« —
and IR partitions
2. Sum to form the output Accumulate

3.

Inverse transform back to the
time domain, advance history
buffer

Outgoing blocks

*0Older blocks are darker

| GDC2019 | Q'
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THIRD LEVEL: HEAD-TAIL CONVOLUTION
PROCESSING

The head-tail method
removes most of the

Frame N Frame N+1

i : . H
work from the critical . Visible to Other Audio Other Audio o
CPU thread and runs it main  *** Processing Processing )
in parallel. thread (CPU) (CPU) ;

Head and Tail blocks

run on GPU. Other Parallel Next
processing can run on tomain == _

CPU. thread Tail
Process only the short :

“head” portion in critical Time —

path, and process the

longer “tail” in- between

audio buffer process *Head performs point-wise multiply and then adds pre-calculated history
calls. from tail

35 | GDC2019 | @iﬂ%@" AMDZA




FOURTH LEVEL: NON-UNIFORM HEAD-TAIL
CONVOLUTION PROCESSING

IR partitioning for 256 frame samples: L # samples, 2N partitions of size B, [ﬁ] number of partitions of size NB

With non-uniform <
head-tail, we get
two key benefits:

1) Reduce the
length of the
“head” process that
IS visible to the

v

Head calculation (one “B” block).

main thread , ) .
e , * Same as for uniform head-tail, but we can use a shorter frame size without
2) Optlml_ze the tail affecting the tail calculation
computation. Tail calculati bef llel GPU ]
Factor of “N” fewer ail calculation (as before, on paralle process):
MACs required — * Tail’s multiply-accumulate computation is roughly N times less compared to
only process part uniform head-tail, as a result, can support much longer IRs
of the history per
tail

36 | GDC2019 | 9 AMDI



TRANSITIONING TO A NEW IMPULSE RESPONSE

 To update to a new
IR kernel:
1) Compute the audio

buffer output for
both the old and

the new IR
2) Crossfade to the
new filter |
» With head-tail, the { IR’s Tail
CPU-visible IR d ‘ convolution
update overhead is ‘
very small 7 X Head ! Head
Fused MAD Kernel Old & New IFHTs Tail uis.mg FHT  transition
for old/new IRs XFade old IR for to new IR
next

37 | GDC2019 | batch Q= AMDIL



STABILITY DEMO:
STEAM AUDIO WITH
3DMARK® TIME

SPY TOGETHER ON D
THE SAME GPU




WHAT THE VIDEO SHOWS

« Captured using Radeon™ ReLive Application

« Left side of screen: Steam Audio workload with Dual RTQ acceleration

« Uses a total of 12 reserved CUs in 2 RTQs
« Top graph: Worst-case convolution latency with settings:
« 512 1-second time-varying convolution channels, rendered as 32 3"4-order Ambisonics
* 4 CUs running TrueAudio Next
« Buffer length is 20.8 ms, SR 48 kHz
« Convolution to take less than %z of the available time

« Bottom Graph: Propagation update time using:
« 8 CUs for Radeon Rays + additional OpenCL code to calculate & transform impulse responses
« 16k Rays, 4 bounces, Sibenik Cathedral scene simulation

« Right side: 3DMark® Time Spy Stress running in window, other settings default*
« Uses the remaining balance of 52 CUs

« System; Radeon™ RX Ve/g I564 CUs, 8G VRAM), default Radeon™ Software
Adrenalin driver settings, AM Ryzen’r 7 1800X with 32G DRAM, Windows 10 64b

*See Endnotes for test details.
39 | GDC2019 | Q= AMDOL



DMark Workload

| e———
Convolution Processing Latency (ms)

¢
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.
.
l ‘
- - Y, |
Propagation Processing Latency (ms)
it
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.
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0.0
= 2
l'll STEAM' AUDIO 4 =
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‘otal Channels :E' TrueAudio Next CUs > RayTracer Radeon-Rays Engne * . - --", »
ey ot eI - Radeon-Rays CUs 8 = PrimaryRays |16384 ¢| uBatchsze 3 , - N e
. N S

mbisonics Order 3 v RESNILRTQs on Star Bounces 4 o - *
Audio Buffer Length 102
onvolution Length (s) 1.0
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BUT WHAT ABOUT MY FRAME RATE?

« Performed test with 3DMark® Time Spy trials measured on Radeon™ RX Vega
64 / Ryzen™ 1800X system (average of 3 trials each scenario). Used default
full-screen settings

« Test Procedure:
1) Measure baseline score of system three times, average the results

2) Repeat three measurements with Steam Audio performance workload (as shown
in video) running simultaneously, average the results

3) Compare % reduction in average score with % of CUs used for audio

 Results:
* % of CUs used = 12/64 = 18.75%
* % Reduction of average Time Spy score = 12.01%"
¢« 12.01% < 18.75%

*See claim details in endnotes

41 | GDC2019 | @iﬂ%@" AMDZA



STEAM AUDIO AND TRUEAUDIO NEXT USED IN
INTERNATIONALLY-ACCLAIMED VR EXPERIENCE

"We implemented Steam Audio with TrueAudio Next in our VR experience ‘Made
This Way: Redefining Masculinity’ and it truly changed the way people interacted
with the testimonials of our subjects in the project. As creators this was incredibly
important for us as we were telling the stories of marginalized people and therefore
it was critical for their voice to be heard. Without a doubt Steam Audio with
TrueAudio Next gave us this power to unlock the empathy of our project and
connect the viewer to the story in a very deep and significant way."

-- Elli Raynai, co-director and co-producer of “Made this Way: Redefining Masculinity” which has been
nominated for a 2019 Canadian Screen Award for Best Immersive Experience — Non-Fiction, and was an
Official Selection at the 75th Venice International Film Festival. o s
4 N
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CONCLUSION
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WITH STEAM AUDIO AND AMD RADEON, GREAT GAME
AUDIO ON THE GPU IS REAL ... AND REAL-TIME

Supported on:

AMD Radeon™ RX 470 AMD Radeon™ RX 480

AMD Radeon™ RX 570 AMD Radeon™ RX 580

AMD Radeon™ RX 590 AMD Radeon™ R9 Fury

AMD Radeon™ R9 Fury X AMD Radeon™ RX Pro Duo (Polaris)
AMD Radeon™ RX Pro Duo (Fiji) AMD Radeon™ Vega Frontier Edition
AMD Radeon™ RXVega 56 AMD Radeon™ RX Vega 64

AMD Radeon™ V]| AMD Radeon™ Pro WX 7100

AMD Radeon™ Pro WX 8200 AMD Radeon™ Pro WX 9100

Use current AMD Radeon™ Adrenalin drivers:

Thanks to:
AMD: Gabor Sines, Geoffrey Park, Seyedreza Najafi, Peter Cao
Valve: Anish Chandak, Clinton Freeman

Additional links:

44 | GDC2019 | @iﬂ%@" AMDZA


https://www.amd.com/en/support
https://valvesoftware.github.io/steam-audio/
https://gpuopen.com/gaming-product/true-audio-next/
https://gpuopen.com/gaming-product/Radeon-Rays/

ENDNOTES

Using AMD Resource Reservation of 12 CUs, accelerating a test workload of Steam Audio with TrueAudio Next and Radeon-
Rays running 512 channels of convolution and 16k rays/4 bounces for 32 3-order Ambisonics sources, the reduction of the
Time Spy score from the system’s baseline score when running the concurrent audio workload was consistently less than the %
of total CUs reserved (12/64). using Radeon™ Software Adrenalin 2019 Edition on the Radeon™ RX Vega graphics card with
Radeon™ Software Adrenalin Edition 18.12.3.0 at 1920x1080 (1080p). Testing conducted at AMD Santa Clara as of January
25t 2019 on the 8GB Radeon™ RX 580, on a test system comprising of Ryzen 7 1800X CPU (3.6 GHz), 32GB DDR4-2128
MHz system memory, and Windows 10 x64. PC manufacturers may vary configurations, yielding different results. With default
settings on Time Spy at 1920x1080, Radeon™ RX 580 scored with Radeon Software Adrenalin Edition 18.12.3, whereas the
Radeon™ RX 580 scored 76.7 FPS with Radeon Soitware Adrenaiin 2019 Edition 19.1.1. Comparing software versions, Radeon
Software Adrenalin 2019 Edition 19.1.1 has 4% faster performance in a popular game. Performance may vary based on use of
latest drivers.

Using AMD Resource Reservation of 12 CUs, accelerating a test workload of Steam Audio with TrueAudio Next and Radeon-Rays running
512 channels of convolution and 16k rays/4 bounces for 32 39-order Ambisonics sources, Time Spy Stress achieved a consistent passing
score, using Radeon™ Software Adrenalin 2019 Edition on the Radeon™ RX Vega graphics card than with Radeon™ Software Adrenalin
Edition 18.12.3.0 at 1920x1080 (1080p). Testing conducted at AMD Santa Clara as of January 25", 2019 on the 8GB Radeon™ RX 580, on a
test system comprising of Ryzen 7 1800X CPU (3.6 GHz), 32GB DDR4-2128 MHz system memory, and Windows 10 x64. PC manufacturers
may vary configurations, yielding different results. With default settings on Time Spy at 1920x1080, Radeon™ RX 580 scored with Radeon
Software Adrenalin Edition 18.12.3, whereas the Radeon™ RX 580 scored 76.7 FPS with Radeon Software Adrenalin 2019 Edition 19.1.1.
Comparing software versions, Radeon Software Adrenalin 2019 Edition 19.1.1 has 4% faster performance in a popular game. Performance
may vary based on use of latest drivers.
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Disclaimer

The information presented in this document is for informational purposes only and may contain technical inaccuracies, omissions and typographical
errors.

The information contained herein is subject to change and may be rendered inaccurate for many reasons, including but not limited to product and
roadmap changes, component and motherboard version changes, new model and/or product releases, product differences between differing _
manufacturers, software chan%es, BIOS flashes, firmware utpgrades, or the like. AMD assumes no obligation to update or otherwise correct or revise
this information. However, AMD reserves the right to revise this information and to make changes from time to time to the content hereof without
obligation of AMD to notify any person of such revisions or changes.

AMD MAKES NO REPRESENTATIONS OR WARRANTIES WITH RESPECT TO THE CONTENTS HEREOF AND ASSUMES NO RESPONSIBILITY
FOR ANY INACCURACIES, ERRORS OR OMISSIONS THAT MAY AP HIS INFORMATION.

AMD SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OF M FOR ANY PARTICULAR PURPOSE. IN NO
EVENT WILL AMD BE LIABLE TO ANY PERSON FOR ANY DIRECT, | L OR OTHER CONSEQUENTIAL DAMAGES ARISING
FROM THE USE OF ANY INFORMATION CONTAINED HEREIN, EVEN IF AMD’IS EXPRESSLY ADVISED OF THE POSSIBILITY OF SUCH

DAMAGES. ’
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